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What is FontSee?

FontSee is a small, yet powerful, utility to help you manage your fonts. FontSee will
both display fonts on screen and print them out in a variety of handy formats. FontSee is
ideal for desktop publishing as it allows you to print a 'catalog' of fonts you have available so
that clients can choose the perfect font that suits their needs. FontSee supports the
following displayable/printed formats:

* Font listings

* Character set listings
* Reference cards

* Rotated views

The above options are available from the Mode menu on the Menu Bar.

FontSee is flexible and allows you to select the character set (or message) to print in
a character set printout. FontSee also allows you to display fonts alphabetically or by family
(e.qg. so that all your Serif fonts are together). For more information on FontSee's many
options please go to the section that describes the Menu Bar.



Printing

Most (but not all) of what FontSee displays on your screen can also be printed. A
printout's appearance depends on what mode you have selected for FontSee to operate
under.

* Fonts - A list of all (enabled) fonts will be printed. Fonts can be enabled/disable from the
Options...Select Fonts dialog box.

* Character Sets - All (enabled) fonts will be printed, but instead of printing their names
FontSee will print a selected group of characters (which can be changed in the
Options...Format Output dialog box).

* Rotated Font - The selected working font (selected via Options...Select Fonts) will be
printed out at several different angles so you can see how this font appears when rotated.

* Reference Card - The select working font will be printed as part of a 2 page reference
card listing all characters contained in the font. This is useful for locating special symbols
such as greek letters and bullets within a font.

* Virtual Keyboard - The virtual keyboard can not be printed. Its primary use is to allow
easy entry of special characters directly into your applications. For example, once you
track down the copyright symbol that you need to insert (and configure FontSee to send
characters to your word processor) you can click on that key and have FontSee type
directly into your document.



History

FontSee was originally developed as my first voyage in Windows programming back
in 1991. Since then, FontSee has been a fairly popular font viewing utility as it is compact
and requires no additional DLLs (as do most other font viewers that have been written in
Visual Basic) and it's easy to use.

When working on my Master's Degree in Computer Science at Northern lllinois
University, | was approached by one of the professors (Dr. Jim Henry) with regard to doing an
independent project which bore the virtual keyboard in FontSee.

After over a year of doing only minor charges (with plans of doing major changes)
this release of FontSee has been completed. It adds on-line help, the ability to sort fonts by
family, rotated views, and other improvements. Should you find this software useful please
register so that you will be made aware of future updates and bug fixes. We will also supply
you with our other shareware programs.

Thanks,

Alan Reeve,
REEVEsoft



The Menu Bar

The FontSee menu bar appears as follows. To find out more about a particular menu

item simply click on that item below. To find out more about using menus please consult

your MS Windows documentation.

Exit

+ Rotated Font
Reference Cards

Keyboard

Set Up Keyboard...

File Mode Sort Options Help
Print Fonts v by Name Select Fonts... Contents...
Printer Setup..] Character Sets by Family | Format Qutput... About




The Virtual Keyboard

FontSee offers a unique capability that is similar to the Character Map utility that is
now bundled with Windows 3.1 with its virtual keyboard. The virtual keyboard allows you to
directly type characters into another application from FontSee. This allows you to use
FontSee to find those special characters like copyright symbols or bullets and have FontSee
type them directly into the word processor (or other application) that you're using!

To use the virtual keyboard you must first select the Set Up Keyboard menu item
under the Options menu. Then click on the Select Target Application button, point your
mouse cursor at the window you want to type in, and click the left mouse button. Your
computer should beep indicating that everything has been correctly selected. This
establishes a line between FontSee and the application you want to type in.

Now, from either the Reference Card or Keyboard mode you can click on keys with
the mouse button and have those characters typed directly into your application.

FontSee also allows you to customize your virtual keyboard and supports two extra
16 key keypads for your use.



Selecting this menu item will generate a printout of the selected fonts on the currently
selected printer. This option is not available in keyboard mode.



Selecting this menu item allows you to select a different printer for printed output.



Selecting this menu item will cause FontSee to display only font names using the font of the
font name (i.e. Times New Roman will be displayed using the font Times New Roman).



Selecting this menu item will cause a selected character set (or message) to be displayed in
each font. This message can be changed by selecting Options...Format Output. If the Fixed
Fonts for names flag is set then each font is preceded by the font's name in a standard font.



Selecting this menu item will display the currently selected font rotated at all angles in 30
degree increments. The first line of the character set chosen to be displayed in Character
Sets mode will be the displayed text. Use Options...Select Fonts to change the currently
selected font. This menu item currently has a check mark next to it indicating it is the
currently selected mode.



Selecting this menu item will cause the currently selected font to be displayed as a
reference card listing each character along with its numerical (ASCII) equivalent. To enter
any of these characters into your application simply press the Alt key followed by 0 and the
ASCII value representing the character you wish to type. Then release the Alt key and the
character will be entered.



Selecting this menu item activates FontSee's virtual keyboard mode. You can not print from
this mode.



Selecting this menu item will cause fonts to be listed alphabetically by name (i.e. Arial
before Wingdings because A comes before W). This menu item currently has a check mark
next to it indicating that it is the currently selected sorting method.



All Windows fonts are grouped into families based on the types of fonts that they are. In this
mode families will be groups together so that all symbol fonts and all swiss fonts and so on
as displayed together. Fonts within a particular family are sorted alphabetically.



Selecting this menu item is how to you into this FontSee help system.



Selecting this item displays information about who created this software.



Selecting this menu item allows you to select a character set (or message) to be displayed
when FontSee is in Character Sets mode. You can also select a font size to use for displaying
fonts. The Fixed Fonts for Names option allows you to enable FontSee to display a font's
name along with the selected character set in character set mode.



Selecting Fonts

FontSee allows you to select which fonts are available for viewing which is especially
helpful on systems with hundreds of available fonts. After clicking this menu item the
following dialog box will appear:

Select Fonls

Working Font:

[] [Times New Roman

(<] Normal L] Halic

[ Bold [ ] Bold-Italic
~ Font Families

] swiss (Sans Serify [ Script (Handwriting)
[ Roman (Serif) [] Decorative
[]Modern (Fixed Pitch) []Other

Enable All | Disable All

This dialog box allows you to:

» Select which fonts are active or inactive
» Select which font families are active or inactive

« Select a new working for (for display in Rotated, Reference Card, and Virtual Keyboard
modes)

To find out more click on the appropriate control in the above dialog box.



Selecting this menu item allows you to pick a program into which you will type with the
virtual keyboard and select which ASCII characters map to each key on the virtual keyboard.



Selecting this menu item terminates FontSee.



The File Menu allows you to Print out listings of your fonts equivalent to what you see on
screen.



The Mode Menu allows you to select among different modes of operation (or display). For
example, you can select to display fonts in their font name or complete character sets or
even use the FontSee virtual keyboard from this menu.



The Sort Menu allows you to select the order in which your fonts are listed when using the
Fonts or Character Sets mode.



The Options menu allows you to configure FontSee.



The Help Menu allows you to get Help on using FontSee (which is what you're doing right
now) and find out other information about this program.



Shareware Registration

To register FontSee and receive the latest registered version along with other
shareware software from REEVEsoft either send a check or money order for $20.00 to us at:

REEVEsoft
P.O. Box 1884
Clemson, SC 29633
(803) 654-7378 * (803) 654-8130 FAX
CIS: 71521,2200 * AoL: REEVEsoft * Internet: reevesoft@aol.com

OR

Call Public software Library at (800) 242-4775, (713) 524-6394, or (713) 524-6398 FAX and
tell them you would like to register FontSee (please mention item #11718) with your Visa,
Mastercard, Amex, or Discover card. Please note that PsL is acting as our agent in accepting
credit card orders and any further inquiries about your order should be directed to REEVEsoft
at the above address.

OR

Use CompuServe's SWREG service:

1) From any prompt on CompuServe type 'GO SWREG'".

2) Select menu item #2 to register.

3) FontSee's item # on CompuServe is 2470.

4) Provide your shipping address. If you would like the registered version emailed to your
account please send us mail requesting that. Your order will be billed to your CompuServe
account.



Clicking on this box allows selection of the working font. The working font is the font that is
displayed in Rotated, Reference Card, and Virtual Keyboard modes.



Clicking on this check box enables (or disables) the working font. If a font is disabled then it
will not be seen in Fonts or Character Sets mode.



Clicking on any of these check boxes allows enabling the working font to have the four
various styles of the font displayed in Fonts mode.



Clicking on any of these buttons will enable or disable the fonts from a font family. Windows
divides all of its fonts into six families:

* Swiss (fonts without serifs)

» Roman (fonts with serifs)

* Modern (mono-spaced fonts like Courier)
« Script (fonts that look like hand writing)
» Decorative (fancy fonts)

 Other (symbol fonts)

If a font family is disabled then none of its fonts will be seen in Fonts or Character Sets
mode.



Clicking this button will enable all fonts.



Clicking this button will disable all fonts.



Clicking on this button exits the Select Fonts dialog box.



Customizing the Virtual Keyboard

To customize the virtual keyboard in the Set Up Keyboard dialog box you need to
know the key number you wish to modify. The virtual keyboard permits usage of the 57 keys
on the main keyboard along with 16 keys on each of two special keyboards (which can be
enabled or disabled by clicking on the Special Keyboard 1 and Special Keyboard 2 check
boxes).

The keys on the main keyboard are numbers from 0 to 56. The keys on the special
keyboards are numbered from 57 to 72 and 73 to 88 respectively. If you wish to use these
keys along with Shift add 128, add 256 for Control, and add 512 for Alternate. Enter this
value in the Key box. Enter the ASCII value that you wish this key to represent in the Value
box (the ASCII values can be easily determined from the Reference Card). Once these two
values have been entered click on Change. You keyboard will be altered. Now, when you
click on this key the chosen ASCII character will be typed instead.

The layout of your virtual keyboard is always saved when you exit FontSee.









